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What’s New in Chief
Architect X6

Welcome to Chief Architect X6. This guide has been 
written to help our upgrading customers make a 
smooth transition from earlier versions of Chief 
Architect to Chief Architect X6. 

Contents
• Before You Begin
• New and Improved Features

Before You Begin
There are many new features in Chief Architect X6, and many existing features have changed. These changes 
affect the way Chief Architect functions, so it is very important to be familiar with them. 

• Getting Started Check List on page 1

• For Files Created in Version X4 and Prior on page 3

• For Files Created in Version X3 and Prior on page 4

• For Files Created in Version X2 and Prior on page 5

Chief Architect X6 can open the .plan, .layout, .PL1, and .LA1 files from prior versions. Before opening any 
files created in earlier versions of Chief Architect, it is important to be aware of changes made in the newest 
version and the effect they may have on your legacy plan and layout files. For details, see For Files Created in 
Version X3 and Prior on page 4,  For Files Created in Version X2 and Prior on page 5. 

As in all software, every new program version introduces changes to its functionality as well as to the user 
interface. If you choose to bring a project forward, be sure to take a few moments to look it over in the new 
version and confirm that the new functionality does not require you to make any modifications. Particularly if 
you have an approaching deadline, you may find it best to finish the current project in the version of the 
software in which you began it. 

Getting Started Check List
The following checklist suggests steps you should take before migrating your files to Chief Architect X6. More 
information about each of these steps can be found after the checklist.

1. Check for and Install Program Updates
2. Migrate Legacy Library Files
3. Migrate Custom Graphics Files
4. Review the New Features List
5. Review Your Preferences Settings
6. Create new custom Template Plan and Layout files
7. Set up Custom Toolbar Configurations
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8. Backup Entire Plan
9. Check www.chiefarchitect.com for more information

1. Check for and Install Program Updates
Program updates contain improvements to the original release version and we recommend using the most 
current version available. By default, Chief Architect checks for program updates every day when you launch 
the program. Please note that program updates are available for download, which means that you need internet 
access to acquire them.

You can check for updates at any time: 

• Select Help> Download Program Updates from the menu. 

• Visit the Program Updates page on the Chief Architect Web site at www.chiefarchitect.com. 

2. Migrate Legacy Library Files 

Library content from previous program versions cannot be installed or copied into the Chief Architect X6 
library. If you upgraded from version X1 or later and have custom library content on your computer from that 
program version, the program installer will locate it and ask if you want to migrate it into the Chief Architect 
X6 library.  

You can import library files from versions X1 through X4 at any time by selecting Library> Import Library 
(.calib, .calibz) from the program menu. In addition, library files from versions 10 and prior can be imported 
by selecting Library> Convert Legacy (.alb) Library Files from the program menu.

3. Migrate Custom Graphics Files
If you have custom graphics files, including textures, images or backdrops, that you were using in a previous 
program version, you can copy them manually using Windows Explorer for use in Chief Architect X6. 

• Copy custom texture files to the Chief Architect X6 Textures folder located in the Chief Architect X6 Data 
folder. 

• Copy custom image files to your Chief Architect X6 Images folder located in the Chief Architect X6 Data 
folder. 

• Copy custom backdrop files to your Chief Architect X6 Backdrops folder located in the Chief Architect X6 
Data folder. 

In Chief Architect X5 through X1, custom graphics were saved in the Chief Architect Data folder, as they are 
in version X6. In version 10 and prior, they were located in the program’s installation directory, in folders that 
began with “My”. Custom backdrops, for example, were saved in “My Backdrops”. 

Texture and image files are not listed in the Library Browser. These files can be assigned to material and image 
objects, however, which are stored in the library so it is important to retain them.

4. Review the New Features List 
There are a number of important reasons why you should familiarize yourself with the new and improved 
features in Chief Architect X6:

• New and improved features allow you to produce drawings more efficiently, so it is to your advantage to 
use them. 

• Some changes to existing functionality may affect your accustomed drawing style and thus your productiv-
ity if you are not aware of them. 

• New features may affect your choice of settings in your template files, as well as your preferred Preferences 
settings. 

See New and Improved Features on page 6. 

http://www.chiefarchitect.com/
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5. Review Your Preferences Settings 

Any changes that you made to the Preferences settings in your previous version do not migrate into Chief 
Architect X6. You should review all the settings in the Preferences dialog to make sure that they are set to suit 
your drawing needs.

6. Create new custom Template Plan and Layout files 

Chief Architect X6 installs a selection of template plan and layout files that have been set up to take advantage 
of the program’s updated tools and features. For best results, it is recommended that you either: 

• Use the installed templates when creating new plans and layout files in Chief Architect X6

• Use the installed templates as the basis for creating new custom templates.

If you choose to continue using custom template files that you created in a previous program version, it is very 
important that you take the time to carefully review all the default settings in the file, making sure that they will 
continue to suit your needs in X6. First, make copies of your custom templates in the Chief Architect X6 The 
Templates directory is located in the Chief Architect X6 Data folder in Windows Explorer. Next, open each 
template as you would a regular plan or layout file, by selecting File> Open, and then save any changes you 
make by selecting File> Save.

If you do choose to continue using a legacy template plan, it is best to also use a legacy layout template from 
the same program version, as well. As with a template plan, take the time to go through the layout template’s 
defaults and make sure they are suited for use in X6 and that their line weight scales do not conflict with those 
in your template plans.

7. Set up Custom Toolbar Configurations 

It is possible to migrate toolbar configuration files from previous versions to Chief Architect X6; however, it is 
not recommended because it is likely that you will be missing new tools available in version X6. 

Instead, we recommend that you set up your custom toolbars the way you would like them in Chief Architect 
X6. You may find it most effective to customize your toolbars as you get used to working in the new program 
version, rather than beforehand.  

8. Backup Entire Plan
Before migrating a legacy file created in Chief Architect X5 or prior, it is a good idea to open the plan in the 
program version in which is was created and use the Backup Entire Plan tool (Export Entire Plan in version X3 
and prior) to export the plan with all associated support files, including textures, backdrops and images.  

9. Check www.chiefarchitect.com for more information
If you have additional questions about the changes in Chief Architect, up to date information is available in the 
Support section of our web site. You can also post questions on the Chief Talk web forum at 
www.chieftalk.com.

For Files Created in Version X5 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X5 or 
prior, bear in mind the following before you open legacy files in Chief Architect X6. 

1. Named Values for Doors and Windows
In Version X6, the Named Values door_style_name, door_type_name, and window_type_name were shortened 
to style_name and type_name. Any object labels or text macros using these Named Values in legacy plans 
opened in Version X6 will need to be replaced.

For Files Created in Version X4 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X4 or 
prior, bear in mind the following before you open legacy files in Chief Architect X6. 

http://www.chieftalk.com/
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1. Roof Overhangs and Framing
In Chief Architect X4 and prior, roof overhangs were measured to the outside of the subfascia, whereas in 
Version X5, they are measured to the outside of the fascia or shadow boards, if present. In legacy plans opened 
in Version X5, this will not affect the appearance of roof planes in floor plan view because in X4 and prior, roof 
plane polylines represented the projected framing area whereas in Version X5 they represent the total projected 
area.  But, the position of the fascia and subfascia will shift, as will the length of the rafters.

2. Door Swing Direction and Materials
In Chief Architect X4 and prior, exterior doors that swing outward display interior material on exterior side of 
door. This was corrected in Version X6. Doors modified to work around the old behavior could be affected in 
legacy plans opened in Version X5.

3. Door Swing Direction and Louvers
Improvements to door louver direction may affect louvers in all doors with the exception of bifold doors.

4. Wrapped Door/Window Lintels and Window Sills
In Chief Architect X4 and prior, wrapped lintels and sills extended out further than those that were not 
wrapped. In legacy plans opened in Version X6, the extents of wrapped lintels and sills will be adjusted so that 
they equal their Extend setting.

5. Cabinet Feet
The offsets for cabinet foot millwork symbols in Version X4 and prior were set per millwork symbol to insert 
into cabinets effectively. In Version X6, the offset is set in the Cabinet Specification dialogs. When legacy 
plans are opened in Version X5, cabinet foot offsets are set to 0 and transferred to their containing cabinet, if 
one exists. Any customized or independently placed cabinet feet will be affected.

6. Object Labels in Cross Section/Elevation Views
If a “Label” layer is turned on in a cross section/elevation view and objects of that type are visible in the view, 
then those objects’ labels will display in that view when the plan is opened in Version X6.

7. Transparent Materials
In Chief Architect X4, materials assigned to the Transparent Material Class for ray tracing were visible in 
rendered views even when their Index of Refraction was set to 1.0. When legacy plans are opened in Version 
X6, Transparent materials with an Index of Refraction of 1.0 are transferred to the General Material class and 
assigned a Transparency value of 100%. This will not affect these materials’ appearance in ray trace views, but 
will make them completely invisible in rendered views.

8. Invisible Beams
The legacy Invisible Beam checkbox was removed from the Wall Specification dialog. When legacy plans are 
opened in Version X6, any Invisible Beam walls will be converted to Invisible Walls. 

For Files Created in Version X3 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X3 or 
prior, bear in mind the following before you open legacy files in Chief Architect X6.

1. Text Styles
The appearance of a number of objects that include text - including object labels, the North Pointer, Sun 
Angles, Joist Direction Lines, the Up/Down arrows for stairs and ramps - can now be controlled using Text 
Style. Their appearance may be altered somewhat in legacy plans opened in Chief Architect X6.

2. Light Sources
The illumination created by light fixtures and Added Lights was improved in Chief Architect X6. Lighting in 
legacy plans may appear noticeably brighter when viewed in version X6.
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For Files Created in Version X2 and Prior
If you wish to open files created in Chief Architect Version X2 or prior, bear in mind the following file 
management changes and structural enhancements before you open legacy files in Chief Architect X6.

1. Material textures, images, and backdrops
Chief Architect X2 and prior installed with a catalog of library content, including a selection of material 
textures, images, and backdrops. This library catalog is no longer installed with the program because it is now 
available for download on-demand, so it will be possible to open a legacy plan in version X6 and encounter 
numerous missing file warnings. To avoid this, we recommend using the Export Entire Plan feature in the 
original program version to create a folder that includes the plan and all associated textures, images, and 
backdrops before opening this file in X6. This tool is renamed Backup Entire Plan in version X6.

2. Floor and ceiling finish thicknesses
In Chief Architect X2 and prior, floor and ceiling finish layers were not modeled in 3D, and objects such as 
railings, stairs, landings, cabinets, fixtures, and furnishings measured their Floor to Bottom height from the 
subfloor. These objects now measure their Floor to Bottom height from the floor finish surface by default, so it 
is possible that you may notice height changes for these objects - particularly in saved, annotated cross section/
elevation views.

3. Riser heights and landing thicknesses
The default Best Fit Riser Height for stairs that do not reach the next level has been updated from 9” (225 mm) 
in version X2 and prior to 6 3/4” (169 mm) in Chief Architect X6.

4. Auto Adjust Height
The Follow Terrain option in some specification dialogs was replaced by the Auto Adjust Height checkbox. If 
a cabinet, fireplace, fixture, furniture, or other library symbol had Follow Terrain unchecked in version X2 or 
prior and was located in a room with a floor height other than the default for the current floor, then the object’s 
Floor to Bottom Height will change to equal that room’s floor height. The object’s position in the model will 
not change, however. 

5. Adjustable Thickness Walls
In Chief Architect X2 and prior, generic, single-layer wall types were available for use. When a legacy plan file 
is opened in version X6 and these wall types are detected, they are replaced by an updated, non-generic wall 
type. Framed walls and Railings will also acquire 1/2” (13 mm) thick layers of sheetrock on each side.

6. Stairwells defined by railings
Interior railings that used a generic, single-layer wall type drawn in older program versions will acquire layers 
of sheetrock when the plan is opened in version X6. This can affect the appearance of staircases where they 
join to a floor platform. To address this issue, select the railing and move it 1/2” (13 mm) away from the top 
edge of the staircase. 

7. Deck rooms
In legacy plans opened in Chief Architect X6, Deck rooms with Advanced Deck Framing built retain the 
framing but have Automatic Deck Framing turned off by default. Decks with no Advanced Deck Framing built 
are converted to Balcony rooms.

8. Material definitions and light sources
Settings in the Define Material dialog that affect materials’ appearance of brightness have been modified. The 
Ambient setting was removed, and the Diffuse setting for materials in legacy plans will be set to 100% when 
opened in version X6. 

The Quality setting for light sources set to use Soft Shadows in ray tracing was also modified. Lights using Soft 
Shadows in legacy plans will be set to use Medium quality. The Light Diameter of light sources in legacy plans 
is capped at 4” (100 mm).
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9. Structural Member Reporting
When a plan created in Chief Architect X2 or prior is opened in Chief Architect X6, Materials Lists are set to 
calculate Total Lineal Length. For a combination of lineal length and piece count, select Mixed Reporting in 
the Structural Member Reporting dialog.

10. Fill New Framing Members
In Chief Architect X2 and prior, Fill New Framing Members was view-specific; in Chief Architect X6 it 
applies to the entire plan. As a result, it is turned off by default in legacy plans opened in version X6.

New and Improved Features
The following is a list of  new and improved features 
in Chief Architect Version X6.

Installation
• License deactivation can now be accomplished 

online.

Program Overview
• Tabbed dialogs have been replaced with dialogs 

with panels.
• Redesigned dialog panels feature vertically col-

umns of settings divided by horizontal headings 
for greater ease of use.

• Object previews in specification dialogs can now 
be resized, rotated, and zoomed. Multiple Ren-
dering Techniques can be used, as well.

• Scroll bars can be turned on/off in any view.
• New View menu.
• The program’s Help is now always contextual: it 

will try to launch the page associated with the 
active tool.

File Management
• The recent file list was moved to the File> Open 

Recent File submenu.

Preferences and Default 
Settings

• New Active Defaults dialog allows you to view 
and modify your currently active Saved Defaults.

• The Active Annotation Set drop-down was 
removed from the Annotation Sets dialog.

• “Modified” Annotation Sets are no longer 
described as such to avoid confusion.

• Annotation Sets and their Saved Defaults are now 
view-specific and retained with saved views.

• New Open Dialogs to the Last Panel Visited 
setting in the Preferences dialog.

• All settings in the General Plan Defaults dialog 
are now applied file-wide rather than being view-
specific.

• The Living Area To settings were moved from 
the Floor 1 Defaults dialog to the General Plan 
Defaults dialog.

• New 2D Zoom and Panning Optimizations 
option in the Preferences dialog.

• All Reset options are now found on the Reset 
Options panel of the Preferences dialog.

• The Text and Page Setup panel of the 
Preferences dialog was renamed the Text panel.

• Legacy Plan and Layout Page Setup options were 
removed from the Preferences dialog.

• The Fixture/Furniture Resize Enable setting 
was removed from the General Plan Defaults 
dialog.

• Obsolete Double Buffer Drawing settings was 
removed from the Preferences dialog.

• Obsolete Hardware Culling, OpenGL Vector 
View and Surface Backdrop settings were 
removed from the Preferences dialog.

Toolbars and Hotkeys
• Improved Toolbar Customization dialog 

includes a searchable button list and table show-
ing toolbar names and the views in which each is 
active.

• The Lock Toolbars setting has been moved from 
the Toolbar Customization dialog to the Tools 
menu and also has a toolbar button that can be 
added to the toolbars.

• Undocked toolbars can no longer be resized.
• Can now create custom keyboard hotkey 

sequences to activate tools.
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Layers
• New Name Filter in the Layer Display Options 

dialog.
• Removed the Current CAD Layer setting from 

the Layer Display Options dialog to reduce con-
fusion.

• Improved feedback in the Layer Display 
Options dialog shows which column is being 
used to sort the table and in which order it is 
sorted.

Creating Objects

Editing Objects
• Removed the obsolete Accurate Move edit tool.

• The Center Object  edit tool is now available 
for use in layout

Walls, Railings, and Fencing
• Invisible Wall tool replaced by the new Room 

Divider  tool. 

• New Edit Wall Layer Intersections  edit tool 
provides control of how individual wall layers 
build at intersections. 

• Can now specify multiple Main Layers for a sin-
gle wall type. 

• Add to Library  tool can now be used to add 
walls to the library for future use in other plans. 

• New Energy Values settings for wall types, 
which are used when exporting to REScheck. 

• New Hang Floor Platform Above on Wall 
specifications. 

• New Bearing Wall specification produces joists 
that either lap or butt over the selected wall. 

• Improved feedback when a wall connection prob-
lem is present in a plan. 

• Increased flexibility displaying upper and lower 
pony walls in views sent to layout. 

• Automatically generated Attic Walls now 
become Invisible if deleted while Auto Rebuild 
Attic Walls is on. 

• New Wall Material Regions  let you replace 
finish layers of walls with custom material layers.

Rooms
• New Conditioned Area settings for rooms which 

are used when exporting to REScheck. 
• New Energy Values settings for floor and ceiling 

platform definitions, which are used when 
exporting to REScheck. 

• New Floor Material Regions  let you replace 
finish layers of floors with custom material lay-
ers.

• New Display as Uppercase checkbox for room 
labels.

Doors and Windows
• Door and doorway jambs are now drawn in floor 

plan view. 
• New Jamb panel in the Door Specification dia-

log. 
• New Frame panel in the Window Specification 

dialog. 
• New Has Frame checkbox and increased maxi-

mum window Frame Depth. 
• New Framing panel in the Door and Window 

Specification dialogs with new Headers, Trim-
mers, and Sill settings. 

• New Include Header option lets you omit head-
ers for individual doors - such as interior doors. 

• New Energy Values panel and settings settings 
for doors and windows, which are used when 
exporting to REScheck. 

• Can now specify a window’s Floor to Bottom 
height as well as its Floor to Top. 

• New Options and Materials panels in the Bay/
Box and Bow Window Specification dialogs. 

• New Size, Ceiling, and Floor settings for Bay, 
Box, and Bow Windows. 

• Inproved usability of settings controlling mov-
able window components. 

• Inproved usability of settings controlling number 
of lites. 

• New Separate Trim and Materials on Each 
Side option lets you specify the appearance of 
each side of interior doors and Pass-Throughs 

 differently. 
• Door and window louvers are now two-sided and 

can have separate interior and exterior materials. 
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• New “Glass Louver”, or jalousie, Type for doors 
and windows. 

• New Hardware on Fixed Section option for 
Doors. 

• New Fire Door setting and Column to Include in 
Door Schedules. 

• Tempered Glass setting is now available for all 
door types except doorways. 

• Can now specify the Number of Hinges assigned 
to a selected door. 

• Can now select a shutter style from the library 
and specify custom shutter Offset values. 

• Can now specify shutters for doors. 
• New “Custom” window type for window sym-

bols. 
• Can now specify custom CAD block to represent 

window symbols in floor plan view. 
• To reduce confusion, the settings for editing 

panel and glass door frames were moved to the 
General panel of the Door Specification dialog. 

• Sliding glass doors included in Window Sched-
ules are now listed as Egress. 

Multiple Floors
• New Step floor/ceiling elevations to match 

existing floor checkbox maintains the floor and 
ceiling heights on the existing floors when a new 
floor is created.

Foundations

Roofs
• Can now specify roof Pitch in Degrees from -89° 

to 89°.
• When a roof plane is deleted, any roof framing 

associated with it is also deleted.
• New Retain Roof Framing checkbox in the 

Roof Plane Specification dialog prevents a roof 
plane’s framing from being replaced when fram-
ing is regenerated.

• Can now choose whether to Include Ridge Caps 
on Auto Roof Returns. 

Stairs, Ramps, and Landings
• Decreased the minimum Width for stairs and 

ramps to 2” (50 mm).

Framing
• Twelve new default layers for framing objects, 

including “Framing, Posts” and “Framing, Sill 
Plates”.

• New Build Framing for Selected Object(s)  
edit tool for walls, roof planes, and ceiling 
planes.

• Settings on Headers panel of the Build Framing 
dialog were moved to the Openings panel of the 
dialog and to the Door and Window 
Specification dialogs. Header size and count can 
now be specified per door or window, and maxi-
mum header count was increased to 10.

• The default Header Depth based on opening 
width now includes the Rough Opening value.

• The specified Header Type is now used when 
wall framing is generated as well as in the Mate-
rials List.

• The framing for Railings  specified as Solid 
can now display in floor plan view.

• Can now specify the width and framing type for 
rim joists in the Build Framing dialog.

• Can now specify the default framing for Fire-
places  in the Build Framing dialog.

• Floor/Ceiling Beams  specified as Bearing 
Beam no longer need a Bearing Line  in 
order to split a platform.

Trusses
• Can no longer delete the Truss Detail if there are 

trusses present in the current plan. 

Trim and Moldings
• New Repeat Distance lets you modify the width 

of a symbol molding assigned to an object.

Cabinets
• Can now specify the material assigned to cabinet 

shelves.
• The width of Clipped and Rounded cabinet and 

countertop corners is now measured along the 
front of the cabinet rather than along the clipped 
edge.

• Increased the minimum distance between cabi-
nets in which automatic fillers will generate in 
metric plans.
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• New Custom Backsplash tool.

Other Objects
• New floor and wall Material Regions let you 

replace finish layers of walls and floors with cus-
tom material layers.

• The individual edges of Face objects can be 
aligned using the Make Parallel/Perpendicu-
lar  edit tool.

Architectural Blocks
• New Display and Size/Position settings in the 

Architectural Block Specification dialog.
• Display of sub-objects in plan view is no longer 

tied to their inclusion in schedules and the materi-
als list.

The Library
• New Retain Aspect Ratio option for fixtures, 

furnishings, and other symbol objects.

View and Window Tools
• Multiple view windows are now tabbed at the 

top.
• View windows can now be torn out of the main 

program window.
• The Cascade and Arrange Icons options for dis-

playing view windows were removed.

3D Views

• The Color  toggle is now available in all Ren-
dering Techniques.

• New Position options for camera callouts. 
• If a cross section/elevation view has been sent to 

layout, the new Automatic option populate’s the 
view’s callout with the name of the layout page. 

Rendering and Ray Tracing
• New panel in the Ray Trace Options dialog lets 

you set the initial values for Image Properties.
• Shadows in 3D views now generate significantly 

more quickly.

Text, Callouts, and Markers
• Can now specify a Prefix and Suffix for the num-

ber or letter at the beginning of  list paragraphs in 

Rich Text . 

• The Numbering Start at setting was removed 
from the Paragraph Options dialog. 

• Undo and Redo are now available in the contex-
tual menu in the Rich Text Specification dialog. 

• Text macros can now be inserted into Callouts 

 and Markers .  
• Can no longer specify the size of bullets in Rich 

Text. 
• The Printed Size Input dialog was renamed 

Print Size Calculator. 
• New Replace Fonts dialog. 

CAD Objects
• Enhanced settings in New CAD Arc dialog. 

Project Management
• New Clear Form buttons in the Designer 

Information and Client Information dialogs. 

Pictures, Images, and Walk-
throughs

• Screen Capture  tool is now easier to use: 
simply click and drag a marquee.

• The Screen Capture Setup dialognow  remains 
open after you click Capture, allowing you to 
create multiple captures more easily.

• Imported pictures, metafiles, and PDF files can 
now be cropped using the edit handles.

Importing and Exporting
• New Export to REScheck  tool exports informa-

tion about a plan’s thermal envelope to REScheck 
(.rxl) file format.

• Can now import and export 3D symbols from and 
to the COLLADA (.dae) file format.

• Can now import and export 3D symbols from and 
to the stereolithography (.StL) file format.

• The Import Drawing Wizard was renamed 
Import Drawing Assistant.

Printing and Plotting
• Can now save any view as a PDF, even if no PDF 

writer is installed.
• The Page Setup and Print dialogs were renamed 

Drawing Sheet Setup and Print View, respec-
tively. 
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• Can now specify the Margins of the drawing 
sheet.

• Redesigned Print View dialog includes a scrolla-
ble, zoomable print preview and DPI setting.

• Improved ability to include and exclude specific 
layout pages as the Print Range.

• Page breaks no longer display in either the 
Drawing Sheet Setup dialog or when Print Pre-
view  or Drawing Sheet  are enabled.

• Line Styles assigned to object surface edges and 
patterns are now maintained when Vector Views 
are printed.

• Obsolete Double Buffered Printing, Line 
Weight, and Height and Width Correction set-
tings removed from Print View dialog.

• Use These Settings When Converting Old Files 
settings removed from the Drawing Sheet View 
dialog.

• Print to File option removed from the Print View 
dialog.

Layout

• New Layout Page Table  tool lets you create 
layout tables of contents.

• New Layout Revison Table  tool lets you 
create revision tables.

• Can now create multiple layout Page Templates 
and assign them to the pages of your choice.

• Can now create custom layout page numbering 
conventions.

• Can now delete pages from a layout when they 
have content on them.

• Can now insert layout pages both before and after 
the current page.

• Can now insert pages into and delete them from a 
layout using the contextual menu in the Project 
Browser.

• Can now specify the floor number shown and the 
Annotation Set used in a floor plan view sent to 
layout in the Layout Box Specification dialog.

• Line Styles are now maintained when Vector 
Views are sent to layout.

• Improved Edit Layout Lines  tool.
• Removed Highlight Weight settings from the 

Layout Line Specification dialog.

• If a cross section/elevation view has been sent to 
layout, the new Automatic Text Below Line 
option populates the view’s callout with the lay-
out page’s Label. 

• Can now specify the drawing order for the Refer-
ence Plan Display in views sent to layout. 

Schedules and Object Labels
• New Move Row and Move Column edit handles 

let you change the order of objects and the col-
umns in schedules .

• New Move Down in Schedule  and Move Up 
in Schedule  edit tools let you move a 
selected object’s position in a schedule.

• Schedule columns can now be renamed in the 
Schedule Specification and Defaults dialogs.

• Can now choose whether to display a schedule’s 
column headings as well as whether to use upper-
case text.

• New Group Similar Objects option lets you 
choose whether to display similar objects as one 
line item or separately.

• Fixtures and appliances set into cabinets can now 
display callout labels associated with a Fixture 
Schedule.

• New “Custom” Window Type for garden win-
dows and other window symbols.

• Can now create separate schedules for Interior 
and Exterior Doors.

• New Columns to Include for door, window, cab-
inet, and electrical schedules.

• Objects included in more than one schedule can 
now display multiple callout labels.

• All objects now derive their schedule Descrip-
tions from the Components dialog.

• New “Totals” row at the bottom of Door and 
Window Schedules that include an Area column.

• Hinge Side and Swing can now be included in 
Door Schedules.

Materials Lists
• The ability to export Materials Lists to .xls file 

format was replaced by export to more flexible 
.xml format.

• Column headings are now included when a Mate-
rials List is printed.
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• Heated Area descriptions were replaced by Ther-
mal Envelope, and are calculated with greater 
accuracy.

• Can now generate a Materials List while a cam-
era view is active.

• Obsolete Export Version 8 Columns Only was 
removed from the Materials List Export dialog.

Ruby Console
• Some named values were shortened.
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